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Welcome to the ArcGIS Schematics Designer tutorial I. 
This first tutorial has been designed to help you understand the 
Schematics Standard Builder and some of the predefined Schematics 
rules. It details a simple way to quickly generate schematic diagrams from 
any feature selection set or trace result highlighted in a map document. 
The only requirement is that your feature classes must be organized into a 
geometric network.

Introducing the sample database’s content

A summary of the Tutorial I database
When the ArcGIS Schematics tutorials were installed on your computer, 
the C:\arcgis\ArcTutor\Schematics\Schematics folder should have been 
created. This directory contains the ElecDemo geodatabase on which the 
first tutorial is based.
This sample database contains an electrical network and a land base.
• The data describing the electrical network is contained in the 

ElectricNetwork feature dataset. This feature dataset comprises 
the ElectricNetwork_Net geometric network composed of feature 
classes: the CapacitorBank, ElectricNetwork_Net_Junctions, Feeder, 
OpenPoint, ProtectionDeviceBank, RegulatorBank, ServiceLocation, 
Substation and TransformerBank feature classes contain all 
the geometric network feature junctions. The PrimaryLine and 
SecondaryLine feature classes concern the geometric network feature 
edges.

• The LandBase feature dataset contains the County polygon features.

Specifications for the tutorial schematic project
The purpose is to create a diagram type to automatically generate 
schematic diagrams from any feature set highlighted after a trace or a 
selection operation in a map containing this geometric network. 
The symbology used to represent the schematic elements in the generated 
diagrams will be similar to that used in the map.
You will also learn how to configure Schematics rules that will be 
executed during your diagram generation to automatically reduce 
some schematic elements contained in your diagram or complete your 
diagram by adding new elements such as containers around some specific 
elements.

Note: In this tutorial, you will use specific functionality and commands 
(Diagram Type Assistant, Import From Feature Layers, etc.) that allow 
you to quickly configure your schematic project in a minimum amount 
of time. To understand in detail how this functionality operates, it is 
recommended that you continue through the ArcGIS Schematics Designer 
tutorial II where the less automated Designer functions are used.

Introducing the tutorial main steps

In this tutorial, the schematic project conception is organized into four 
exercises:
• The purpose of the first exercise is to create the schematic dataset that 

will contain all the schematic data related to the schematic project 
you will build and specify some default parameters for the related 
schematic project.

• During the second exercise, you will create the schematic diagram 
type that will be used to generate schematic diagrams on the fly from 
any set of features highlighted in a .mxd document containing the 
ElectricNetwork_Net geometric network data. This diagram type will 
work with the Standard Builder.

• The purpose of the third exercise is to customize the schematic diagram 
display.

• The last exercise concerns the predefined Schematics rules that can be 
automatically executed during the generation of diagrams that work 
with the Standard Builder. You will learn about how to specify some 
rules parameters.

Introducing the Schematics Designer tutorial I
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In this exercise, you will learn to create a new schematic dataset, edit the 
related schematic project parameters within Schematics Designer, and 
specify some predefined default values for main parameters.

Creating a schematic dataset

1. Start ArcCatalog. 
2. Click the Tools menu and click Extensions. 
3. Check the Schematics check box.
4. Click Close
5. Select C:\arcgis\ArcTutor\Schematics\Designer in the Catalog tree.  
6. Create a new file geodatabase in the Catalog tree and type a new 

name for this geodatabase (TutorialI_SchematicDatabase, for 
example). 

Note:  You can also create a new personal geodatabase or use an existing 
SDE geodatabase.
7. Right-click this geodatabase and point to New > Schematic Dataset. 

A new schematic dataset appears in the Catalog tree.
8. Type a new name for this schematic dataset (TutorialI, for example).

Editing the related schematic project within Designer

1. Right-click the new schematic dataset in the Catalog tree and click 
Edit Project. 
The Schematics Designer application starts, loads the associated 
schematic project parameters in memory, and opens directly 
in Design mode. As no diagram type already exists in this new 
schematic dataset, the Diagram Type Assistant automatically 
launches.

2. Cancel the Diagram Type Assistant for the moment.

Note: Exercise 1 of the ArcGIS Schematics Designer Tutorial II provides 
you more details about creating and editing schematic datasets and 
projects.

Exercise 1: Creating a schematic dataset and defining the main parameters

Setting schematic project default parameters

The Default Node Symbol parameter available from the General tab is the 
parameter that is used by default to represent schematic nodes when their 
own Symbol parameter (defined for their related node element type) is not 
set.
To define this default symbol, follow the steps below:
1. Click the Default Node Symbol field.
2. Click the Edit Symbol button to launch the NgUSymbolEditor utility, 

the Schematics CGM symbol editor and vector drawing tool.
3. Use the NgUSymbolEditor drawing tools to build your CGM symbol 

as desired and type a name for the current symbol (File > Save As 
menu).

4. Close NgUSymbolEditor (File > Exit).
The Default Node Symbol field is automatically completed by the name 
of the symbol you have just created.
Parameters defining text effects that will be used by default to display the 
labels when these effects are not defined during the label definition, are 
available from the Schematic Project Effects tab. They are assembled into 
the Text Effects subset of parameters.
5. Click the Effects tab.
6. Click the Text Color field that will define the default color for the 

labels, and click the color box that displays to launch the Table Color 
Editor.

7. Choose or define a color and click OK.
8. Click the Text Font field that will define the default text font for the 

labels.
9. Click one of the default fonts already defined from the drop-down 

list, or click the Ellipsis button displayed on the right to open the 
Font Editor. The Font Editor lists all fonts installed on your computer 
and allows you to choose the font you want.
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Parameters defining the Selection Style are assembled on the Highlighting 
tab.
Three selection styles are available:
• With the Handle style, a selected schematic element is singled out by 

the display of its bounding box.
• With the Highlight style, a selected element is singled out by specific 

color, width, style, and fill.
• With the Handle And Highlight style, the two Handle and Highlight 

selection styles are combined.

When the Highlight or Handle And Highlight style is used, some line, 
fill, and text effects must be set to complete the selection style definition 
and the appearance of links, nodes, and labels when they are selected in a 
schematic view.
10. Choose Handle And Highlight from the Selection Style drop-down 

list.
11. To specify the color for the selected lines, click the Line Color 

parameter, click the color box to launch the Table Color Editor, and 
choose or define the desired color that will be used to highlight lines 
when they are selected.

12.  To define the selected lines’ width, click the Line Width parameter 
and type the desired value.

13. For defining the effects for the selected fills, click Solid from the Fill 
Style drop-down list and define the Fill Color parameter. These fill 
attributes will be used to display the symbol fill of the nodes that will 
be selected.

14. To define the effects for the selected labels, click the color box that 
displays when clicking the Text Color field. In the Table Color Editor 
that opens, choose or define the color you want.

15. Click OK to validate.
16. Click Save. 

By default, the schematic project definition coherence is checked 
before Schematics saves the project. This causes the Please verify 
dialog box to open before the saving is done. This dialog box sums 
up some points that may have been forgotten during your schematic 
project building such as creating an element type without associating 
it with a diagram type, creating link element type without specifying 
the OriginNode and ExtremityNode attributes, creating an element

  type without specifying its identifier, etc. Note that the Please verify 
dialog box lists warnings with a critical level mark (red, orange, 
or green traffic light) without preventing the saving. In fact, each 
warning is only informative and your project definition can be 
completely operational, even if red warnings display in the dialog 
box.

17. Uncheck the Do not perform this verification when saving anymore 
check-box, and click Yes.

18. Close Schematics Designer.
Note: The schematic project parameters are more detailed in exercise 2 of 
the ArcGIS Schematics Designer tutorial II. For more information about 
the parameters available from the Schematic Project’s General, Effects, 
and Highlighting tabs, please read this section.
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Exercise 2: Generating schematic diagrams on the fly

The purpose of this exercise is to create a new schematic diagram type 
that works with the Standard Builder to generate schematic diagrams on 
the fly from any selected feature set or trace result in ArcMap. Creating 
such a diagram type is easier than creating a diagram type that works with 
the Custom Query Based Builder because there are specific commands 
in Designer that allow you to define it with minimum setup work 
and configuration. The standard way to create such a diagram type is 
organized into two steps:
1. Create an ArcMap document containing the geometric network data 

you want to use to generate schematic diagrams, then symbolize this 
data.

2. Create the schematic diagram type that will implement the schematic 
diagrams, and use the Import From Feature Layers command to 
quickly create the schematic element types that will implement the 
schematic diagrams’ content based on the ArcMap document’s TOC.

Starting from an ArcMap document

When working with Schematics, you often have a map, map template, 
or layer file that contains the feature layers that comprise the geometric 
network with which you want to work and generate schematic diagrams. 
The symbology used to represent the feature layers in your ArcMap 
project is often already defined, categories have been created, and you are 
familiar with the representation. ArcGIS Schematics offers the possibility 
of using these layer definitions to quickly create schematic element types. 
This point will be detailed in the next section. The purpose here is to 
create an ArcMap document based on the ElectricNetwork_Net geometric 
network stored in the ElecDemo database.
1. Start ArcMap with a new empty map.
2. Click Add Data and browse to the ElecDemo database that should 

have been installed in C:\arcgis\ArcTutor\Schematics\Schematics.
3. Expand the ElectricNetwork feature dataset, select ElectricNetwork_

Net, and click Add.
4. Click Add Data again, browse to the ElecDemo database, select 

LandBase, and click Add.
5. Click Selection and click Set Selectable Layers.
6. Click Select All and then uncheck the HartGIS.County check box.

7. Close the Set Selectable Layers dialog box.
8. Configure the feature layers as you want. You can define categories 

for some of them if you want.
9. Save your .mxd file.
Below is a configuration sample in which:
• A particular symbol has been specified to represent the CapacitorBank, 

ElectricNetwork_Net_Junctions, Feeder, OpenPoint, RegulatorBank, 
ServiceLocation, and Substation feature junctions.

• TransformerBank junctions are categorized according to their 
Placement and PhaseCode couple value fields.

• ProtectionDeviceBank junctions are categorized according to their 
BankType, Unitcount, and Enabled triplet value fields.

• SecondaryLine feature edges are categorized according to their  
Placement subtype field values.

• PrimaryLine feature edges are categorized according to their Feature 
and Placement couple field values.
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Creating a schematic diagram type to generate 
schematic diagrams from a map document

The purpose now is to create a schematic diagram type to generate 
schematic diagrams on the fly after a selection or a trace operation from 
any selected feature set in the .mxd document you have created. 
In this exercise, you will learn how to use the Diagram Type Assistant to 
quickly create and specify such a diagram type.
1. Start ArcCatalog, and activate the Schematics extension.
2. Browse to the personal geodatabase that contains the schematic 

dataset you created in exercise 1.
3. Right-click this schematic dataset and click Edit Project. 

Designer starts and your schematic project opens. 
Since no schematic diagram type already exists in this schematic 
dataset, the Diagram Type Assistant automatically opens.

4. In the Name/Builder tab, type a name for the schematic diagram type 
in the Name text box. For example, type ‘OnTheFlyDiagrams’.

5. Make sure that Standard Builder is selected in the Schematic Builder 
drop-down list. 
At the end of these steps, the Name/Builder tab content should be 
similar to the following:

You must now define the schematic element types that will implement the 
schematic elements contained in the schematic diagrams related to this 
diagram type. As you want to use this diagram type to generate schematic 
diagrams from selected feature sets in the .mxd document you created in 
the previous section, the best way to complete this diagram type definition 
is to use the Import From Feature Layers command. This command 
creates schematic element types related to the feature layers displayed in 
a .mxd document.

6. Click the Element Type Associations tab.
7. Then click the Import From Feature Layers button. 

The Import From Feature Layers dialog box opens.
8. At the right of the Map or Layer File field, click the Ellipsis button, 

browse to the .mxd file you previously created, select it, then click 
Add. 

9. All feature layers contained in this .mxd document should display 
in the Select the feature layers to import area. The 11 feature layers 
that comprise the ElectricNetwork_Net geometric network should 
be out of line to the right of the first ElectricNetwork_Net entry. The 
HartGIS.County feature layer that is not included in the geometric 
network appears in the list at the same level of the geometric network 
entry. The check boxes corresponding to the ElectricNetwork_Net 
feature layers should all be checked by default. Keep them checked.

10. Check the HartGIS.County check box.
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11. Click OK. 
The Import From Feature Layers dialog box closes. The Element 
Type Associations tab should display as follows:

12. Click OK to close the Diagram Type Assistant dialog box.
In this example, after the complete import, the OnTheFlyDiagrams new 
diagram type displays under the Diagram Types entry.

The Associated Element Types tab related to this diagram type contains 
all the element types that have been created during the import process and 
that correspond to the feature layers you checked. 
If you expand the Element Types entry, you will find that an element 
type related to the CapacitorBank, ElectricNetwork_Net_Junctions, 
Feeder, OpenPoint, RegulatorBank, ServiceLocation, Substation, 
TransformerBank, ProtectionDeviceBank, PrimaryLine, and 
SecondaryLine geometric network feature layers and to the HartGIS 
County feature layer should have been created.

A symbol has been created to display each schematic node in 
the same way as in the ArcMap document. When checking the 
ProtectionDeviceBank and TransformerBank node element types, you 
can note that an attribute and a property have been created to display each 
related schematic node according to database field values in the same way 
as their associated junctions are categorized in ArcMap.
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When expanding the PrimaryLine and SecondaryLine element type 
entries, you can also see that an attribute and a property have been created 
to display the related schematic links according to database field values as 
they are in the .mxd file.

13. Click Save.
All schematic components required to generate a schematic diagram 
from a selected feature set or trace operation highlighted in your .mxd 
document are now available. You may test how this new diagram type 
works.
14. Close Designer.

15. Start ArcMap and activate the Schematics extension.
16. Activate the Schematic, Schematic Editor, Schematic Network 

Analyst and Utility Network Analyst toolbars.
17. Load the .mxd file you created in the previous section.
18. Make sure the HartGIS.County layer is not selectable.
19. Click the Select Features tool and create a selection set of features in 

your map.

20. Click the Generate New Schematic Diagram command. The New 
Schematic Diagram dialog box opens.

21. Click the Browse button next to the Schematic Dataset or Folder 
drop-down list to select the TutorialI schematic dataset in the 
TutorialI_SchematicDatabase geodatabase.

22. From the Diagram Type drop-down list, click OnTheFlyDiagrams.
23. In the Schematic Diagram Name field, type a name for the schematic 

diagram that will be generated (Selection1, for example).
24. By default, the Selection Set In Data Frame option is checked in the 

Input From area.
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25. Click OK.
The new schematic diagram is generated. At the end of the generation 
process, a new schematic diagram containing the schematic elements 
associated with the selected set of features is displayed. The symbology 
used to represent the schematic elements should be similar to the 
symbology used to represent the associated features in the map.

26.  Reactivate your map data frame and then use the Utility Network 
Analyst toolbar to create a trace result.

Below is a sample trace result obtained with the Find Connected trace 
task:

27. Click the Generate New Schematic Diagram command.
28. From the New Schematic Diagram dialog box that opens, make 

sure that the TutorialI schematic dataset is currently selected in the 
Schematic Dataset or Folder drop-down list .

29. From the Diagram type drop-down list, click OnTheFlyDiagrams.
30. In the Schematic Diagram Name field, type a name for the schematic 

diagram that will be generated (“Trace1”, for example).
31. By default, the Tracing Result option is checked in the Input From 

area.
32. Click OK.
At the end of the generation process, a new schematic diagram containing 
the schematic elements associated with the set of features currently 
highlighted in the map is displayed.
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33. From the Utility Network Analyst toolbar, click Analysis and click 
Clear Results. Repeat this operation to clear the flags and barriers 
you have specified.
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Exercise 3: Customizing the schematic diagrams display

The purpose of this exercise is to learn how the generated schematic 
diagrams display can be customized.

Displaying vertices along links

1. Close ArcMap and edit your schematic project with Designer.
2. Click the OnTheFlyDiagrams entry under the Diagram Types main 

entry and click the Schematic Builder field in the General tab. Then, 
click the Ellipsis button that displays on the right. The Standard 
Builder Property Page tab displays.

3. Check the Initialize links vertices check box.

4. Click OK to validate.
5. Click Save and close Designer.
6. Now, launch ArcMap and open your .mxd file. Select a set of features 

in the map and use the Generate Schematic Diagram command to 
generate the new OnTheFlyDiagrams schematic diagram from the 
current selection set.

At the end of the process, a new schematic diagram should open. 
Schematic links contained in this diagram should now be displayed with 
their vertices.

Note that for all schematic diagrams you have previously generated, if 
you reopen them, they display without vertices along links. To display 
vertices along these diagrams’ links, you need to update the schematic 
diagram content.

7. Click Open Schematic Diagrams, browse your Schematic Dataset, 
and choose one of the diagrams you  generated previously.

8. Click Schematic menu and click Update Diagram. The Update 
Diagram dialog box opens.

9. Make sure the Initial features option is selected and click OK. 
After the diagram updates, vertices should display along the links.
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Creating properties and attributes

Attributes and properties can be created to document and symbolize 
the content of schematic diagrams that work with the Standard Builder. 
The purpose in this section is to display the Circuit Description of the 
feeders at the top of each Feeder node and to animate the ServiceLocation 
nodes according to the value of the OnWhat database field related to the 
associated feature junction.
1. Edit your schematic project with Designer.
Labeling the Feeder nodes
Before creating the textual property that will be used to display the labels 
at the top of the Feeder nodes, you must create the attribute that will 
return the Feeder CIRCUITDESC field values.
Schematic elements contained in diagrams generated by the Standard 
Builder are managed in a different way from those managed by the 
Custom Query Based Builder. During each schematic diagram generation, 
the Standard Builder proceeds in two steps:
• First, it analyzes the highlighted features in the ArcMap document, 

decodes the topology related to these features from the geometric 
network, builds all associated schematic nodes and links, and pulls 
these elements into specific schematic tables it has created in the 
schematic dataset.

• Second, by querying the set of elements stored in the schematic tables, 
the generated diagram opens.

For the element types managed by the Standard Builder, there are two 
specific types of attributes that can be created:
• The Dynamic attribute retrieves field values directly from the feature 

class or table with which the schematic element type is associated.
• The Static attribute imports field values from the feature class or table 

with which the schematic element type is associated into the schematic 
dataset during the diagram generation process.

Note that if you create a Static Attribute and use it to document 
or animate your schematic elements, you will have to update any 
previously generated diagrams so the attribute values can be pulled 
into the schematic database and the elements display according to these 
values. With a Dynamic Attribute, the impact on the schematic element 
representation is automatic.

10. Close ArcMap.
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In this example, you are going to create a Dynamic attribute related to the 
CIRCUITDESC field stored in the Feeder feature class:
2. Right-click the Feeder element type entry that corresponds to the 

Feeder feature layer created during the import process.
3. Click Create Attribute.
4. From the Create Element Type Attribute dialog box that opens, type a 

name for the attribute (Label, for example).
5. From the Type drop-down list, click Dynamic Attribute. 

6. Click OK. 
The Attribute Editor dialog box opens.

7. From the Feature Class/Table Fields list, click CIRCUITDESC and 
click the Right arrow to validate this field.

8. Click OK. 
The newly created attribute should display as follows:

Now, you have to create the textual property that will be used to display 
this label.

9. In the Designer tree, right-click the Feeder element type entry and 
click Create Property.

10. From the Create Property dialog box that opens, type a name for the 
property (DisplayLabel, for example) and keep the Textual option 
and the default String Value Type.

11. Click OK.
12. From the newly created property’s General tab, click the attribute you 

have just created from the Attribute Name drop-down list.
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You must now specify how the labels will be displayed on each Feeder 
node’s symbol. Labels on nodes are usually placed according to the 
reference point of the symbol used to represent these nodes. This 
reference point is the center of the symbol. In this example, you will learn 
how to create label ports that will be used to attach your labels.

13. In the Designer tree click the Feeder element type entry, click the 
Symbol Name field on the General tab, and click the Edit Symbol 
button  that opens the vector drawing tool (NgUSymbolEditor).

14. Click Fit All and use the Zoom Out and Zoom In tool to fit on the top 
of the symbol.

15. Click Insert, point to Port, and click Label Port.

16. Click at the top of the symbol to place a label port.
17. If needed, zoom to this location to check the label port position and 

reposition it if you want.

18. Click Save and close NgUSymbolEditor.
Then, you can specify that you want your label to be attached to these 
label ports.
19. Click the DisplayLabel textual property you previously created and 

click the Effects tab.
20. For the Label Port parameter type 1. Set the Text Color you want.

21. Click Save.
22. Close Designer, launch ArcMap and load your .mxd file.
23. Activate your map data, right-click the Feeder feature layer, and 

point to Selection > Select All.
24. Then, click Selection > Zoom To Selected Features.
25. Use the Select Features tool to redefine a selection set containing 

the already selected Feeder junctions and some of their neighbor 
features.

26. Then, use the Generate Schematic Diagram command to generate 
the new OnTheFlyDiagrams schematic diagram from the current 
selection set. 
At the end of the process, a new schematic diagram should open. 

27. If needed, use the Increase/Decrease Symbol Sizes and Increase/
Decrease Text Sizes buttons to adapt your elements’ sizes.
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Symbolizing the ServiceLocation schematic nodes
In this example, you are going to create a discrete property that will be 
used to categorize the ServiceLocation nodes according to the OnWhat 
database field values. There are seven possible values for this field: 
Building, Cabinet, Other, Pole_Cons, Pole_Prim, Pole_Sec, and Temp. 
You will take interest in the Building service location only; that is, you 
will represent the ServiceLocation schematic nodes with a particular 
symbol only when these elements are associated with a ServiceLocation 
feature junction for which the OnWhat field value is Building. For the 
other ServiceLocation nodes, the symbol used to represent them in the 
schematic diagrams will stay similar to that used in the map to represent 
the associated ServiceLocation feature junction. 
You are going to start creating a Dynamic attribute related to the OnWhat 
field stored in the ServiceLocation feature class:
1. Edit your TutorialI schematic project within Designer.
2. Right-click the ServiceLocation element type entry in the Designer 

tree and point to Create Attribute.
3. From the Create Element Type Attribute dialog box that opens, type a 

name for the attribute (What, for example), click Dynamic Attribute 
from the Type drop-down list, and click OK.

4. In the Attribute Editor dialog box that opens, double-click OnWhat 
from the Feature Class/Table Fields list and click OK.

 After having zoomed in on the Feeder schematic elements contained 
in this new generated diagram, you should obtain a result similar to the 
following:

28. Close ArcMap.
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You must now create the discrete property that will be used to categorize 
the ServiceLocation nodes according to these attribute values:
5. In the Designer tree, right-click the ServiceLocation element type 

entry and click Create Property.
6. From the Create Property dialog box that opens, type a name for the 

property (DisplayOnWhat, for example), check the Discrete option, 
and keep the default String Value Type.

7. Click OK.
8. From the newly created property’s General tab, click the attribute you 

have just created from the Attribute Name drop-down list.

Then, you need to create the discrete filter that will be used to filter out 
the ServiceLocation whose related OnWhat field value is Building:
9. Click Add Filter.
10. From the Add Discrete Filter dialog box that opens, type a name for 

the filter in the Name text area (Building in this example).
11. Type Building in the Value text area, and click OK

The new Filters tab should display among the discrete property’s tabs 
with a single item related to the Building filter.
12. Select this item and click the Ellipsis button that displays at the end.

Then, from the Filter Effects dialog box that opens, specify the 
parameters you want to customize for the symbol used to represent the 
schematic nodes that will verify this filter. 
In this example, the default symbol is kept; the symbol color and a 
specific angle are the only parameters that have been modified.
Note: In this example, since the CGM symbol used to represent the 
ServiceLocation uses a specific font character, modifying the color of the 
symbol consists of modifying the Text Color parameter.
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13. Close the Filter Effects dialog box.
14. Click Save and close Designer.
15. Launch ArcMap and load your .mxd file.
16. Click Open Schematic Diagrams and open one of the diagrams you 

have previously generated. 
If this diagram contains ServiceLocation schematic nodes, the 
symbol representing these nodes should now be different for the 
Building ServiceLocation nodes.

Note: If instead of creating a Dynamic attribute related to the OnWhat 
database field, you had created a Static attribute, you would have to 
update your generated diagrams so the new property effects would be 
reflected in these diagrams.
17. Close ArcMap without saving the .mxd file.
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Exercise 4: Specifying schematic rules

In this exercise, you will learn about schematic rules. Predefined 
schematic rules can be used to simplify diagrams (reduction rules) or 
create new elements, such as containers that are related to the elements 
contained in these diagrams (relationship rules). 
Predefined rules provided with ArcGIS Schematics 9.2 only work with 
diagrams managed by the Standard or Network Analyst builder.  Rules 
specified for these diagram types are executed during schematic diagram 
generations. 
In the following sections, you will learn about three rules: Node 
Reduction By Priority, Relationship, and Spatial Query.
• The Node Reduction By Priority rule allows you to generate schematic 

diagrams after all nodes or some particular nodes related to a given 
schematic element type have been removed and after the links that 
connected these removed nodes have been reconnected on a given 
target node so the topology is preserved.

• The Relationship rule allows you to create schematic elements and 
relations regarding the information stored in a relationship class from 
the set of features currently selected in the map.

• The Spatial Query rule allows you to add new schematic elements from 
one or more schematic element classes based on where their associated 
features are located in relation to the features related to another 
schematic element class.

Several rules can be specified for your diagrams. They are chained in their 
entry sequence order during each diagram generation process.
• In this exercise, you will first specify parameters for a Spatial Query 

rule that will be used to detect and automatically complete the 
generated schematic diagrams by the secondary network elements that 
are very close to each selected TransformerBank feature.

• Then, you will specify relationship rules that will be used to 
automatically add the counties related to the TransformerBank and 
ServiceLocation schematic nodes contained in a diagram and display 
them as containers around the TransformerBank and ServiceLocation 
into this diagram.

• At the end, you will specify parameters for a Node Reduction By 
Priority rule that will be used to simplify your generated diagrams 
by reducing the ElectricNetwork_Net_Junctions elements. Only the 
junctions with 1 connection (1 link) will be kept.

Specifying a Spatial Query rule

Rules executed during schematic diagram generation are specified 
through the Rules tab related to its diagram type.
1. Edit your TutorialI schematic project within Designer.
2. Click the diagram type entry in the Designer tree 

(OnTheFlyDiagrams, in this example).
3. Click the Rules tab from the right part of the Designer Editor 

window.
4. Click Add Rule at the right bottom corner of this tab. 

A new empty item should appear in the first line of the tab.
5. Click the Name field, and choose Spatial Query Rule from the drop-

down list.
6. Click the Description field and click the Ellipsis button that displays 

at the end of the rule item. 
The Spatial query rule attributes tab opens.



20

In this example, the Spatial Query rule will be used to detect all 
secondary network elements within a distance of 1 meter from any 
TransformerBank and automatically add these elements into the 
generated diagrams. When link elements are added, their origin and 
extremity nodes are also automatically added by the rules, you only need 
to ask for adding the SecondaryLine links.
7. Type a name for this rule in the Description text box (for example, 

Adding secondary elements near TransformerBank).
8. Check SecondaryLine element class check box in the Add the 

schematic elements of the schematic element classes list.
9. Click ‘are within a distance of’ from the ‘that associated features’ 

drop-down list.
10. Choose TransformerBank from the ‘one feature associated with a 

schematic element of this schematic element class’ drop-down list.
11. Make sure the Apply a buffer to the feature in TransformerBank of 

check box is checked.
12. Type 1 in the text area below and select Meters from the drop-down 

list.
13. Since you want the rules to simply add the detected elements to the 

generated diagram, make sure that the Add elements to diagram 
check box is checked.

14. Check the Keep vertices check box so the vertices along links are 
kept.

15. Click OK.
16. Save the schematic project definition and close Schematics Designer.
It’s time now to test the impact of this first rule in your schematic 
diagrams.
17. Launch ArcMap and load your .mxd file.
18. Open one of the schematic diagrams you previously generated.
19. Click Schematic and point to Update Schematic Diagram.
20. Make sure the Initial features option is selected in the Update 

Diagram dialog box that opens and click OK.
Here is the result of the Update diagram command on the Selection2 
diagram sample.
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If you compare this updated diagram with the one before the update (see 
page 11), you can see that (1) SecondaryLine links, that are very close to 
TransformerBank nodes intially contained in the diagram, are now also 
contained in the diagram, (2) ServiceLocations nodes that often consitute 
the SecondaryLine links’ extremities have been also automatically added 
in the updated diagram.
Here is another sample of a generated diagram from two 
TransformerBank features selected in the map.

This screen shot shows the set of features selected in the map from 
which the diagram generation starts. Among these features, two 
TransformerBank features are seleted.
The following screen shot shows the resulting schematic diagram:
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As in the geodatabase, there is a relationship class related to the 
TransformerBank feature class. All the controls in the tab are 
automatically available.
9. Make sure that County_TransformerBank is selected in the 

Relationship class name drop-down list.
10. Make sure that County is specified as the target element class in the 

Select a target drop-down list.
11. Then, check Add target element(s) to diagram so the counties 

related to the TransformerBank elements as specified in the County_
TransformerBank relationship class are automatically added in the 
generated diagram.

Then you have to specify how the relation must be represented in the 
generated diagram. Checking the Relate source and target elements causes 
the schematic source elements to be represented as containers around the 
schematic target elements to which they are related. In this sample, since 
it is the County targets you want to be represented as containers around 
the TransformerBank sources, you will have to reverse the relation.
12. Check the Relate source and target elements check box.
13. Check the Reverse relation check box.
At the end of these steps, the Relationship rule attributes tab should 
display as follows:

Specifying a Relationship rule

You will now chain this Spatial Query rule execution with a second set 
of rules, Relationship rules, which will be used to add and display county 
elements as containers around the TransformerBank and ServiceLocation 
elements contained in a schematic diagram.
1. Close ArcMap and edit your TutorialI schematic project within 

Designer.
2. Click the diagram type entry in the Designer tree 

(OnTheFlyDiagrams, in this example).
3. Click the Rules tab from the right part of the Designer Editor 

window.
4. Click Add Rule at the right bottom corner of this tab. 

A new empty item should appear in the second line of the tab.
5. Click the Name field and choose Relationship Rule from the drop-

down list.
6. Click the Description field and click the Ellipsis button that displays 

at the end of the rule item. 
The Relationship rule attributes tab opens.

7. Type a description for this rule in the Description text box (for 
example, Adding containers related to TransformerBank)

8. Click TransformerBank from the Select a source drop-down list.
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14. Click OK to close the tab.
15. Click Save.
The symbol used to represent the container elements must be appropriate. 
Generally, using a squared polyline is the best way to graphically 
represent them. In this sample, you now need to create and specify the 
symbol that will be used to represent the County as containers.
16. Expand the Element Types entry in the Designer tree and choose 

County.
17. From the related General tab, click the Symbol Name field and click 

the Edit Symbol button that displays.
18. The NgUSymbolEditor tool opens. Click the Insert Polyline tool and 

use it to draw a square centered on the reference point. 
Double-click this square to open the Graphic Attribute dialog box 
that allows you to specify the line attributes. Click OK after having 
specified these attributes. 
Save the newly created symbol and close NgUSymbolEditor.

The following screen shot shows the County’s General tab content 
obtained after this configuration.

19. Save the schematic project definition and close Schematics Designer.
20. Start ArcMap and load your .mxd file.
21. Update any diagram you have previously generated. 

It should now display with one or several containers representing 
the county related to the TransformerBank elements contained in the 
diagram.

The following screen shot shows the update of the diagram obtained from 
the two selected TransformerBank features that were used to exemplify 
the previous rule (see page 21). Since the TransformerBank elements 
contained in this diagram were related to two counties, two containers 
now display around these TransformerBank elements in the updated 
diagram.

In the ElecDemo geodatabase, there is a second relationship class, 
County_ServiceLocation, that specifies the County related to each 
ServiceLocation feature.
22. Repeat steps 1 to 13 to create a new Relationship rule that will 

relate each ServiceLocation schematic element to its County in the 
generated schematic diagrams.

The following screen shot shows the Relationship rule attributes tab 
content after these steps:
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Specifying a Node Reduction By Priority rule

In this section, you will specify a last rule, a Node Reduction By 
Priority rule, that will cause the reduction of ElectricNetwork_Net_
Junctions elements in your generated schematic diagrams. Only the 
ElectricNetwork_Net_Junctions nodes that have 1 connected link will 
be kept, that is the ElectricNetwork_Net_Junctions node with degree 
1. The target node used to reconnect the incident links of the reduced 
nodes will be determined according to a list of element types in order 
priority: Substation, Feeder, TransformerBank, ServiceLocation, 
ProtectionDeviceBank, and CapacitorBank.
1. Edit your schematic project within Designer.
2. Click the diagram type entry in the Designer tree and click the Rules 

tab from the right part of the Designer Editor window.
3. Click Add Rule at the right bottom corner of this tab. 

A new empty item should appear in the fourth line of the tab.
4. Click the Name field and select Node Reduction By Priority from the 

drop-down list.
5. Click the Description field and click the Ellipsis button that displays 

at the end of the rule item. 
The Node reduction by priority rule attributes tab opens.

6. Type a name for this rule in the Description text box (for example, 
Reducing NetworkNet Junctions).

Since the ServiceLocation elements are now related to the County, the 
containers that represent the counties automatically enlarge to incorporate 
the ServiceLocation elements.

23. Click OK to close the tab.
24. Click Save.
25. Test the impact of this new definition in your generated diagrams by 

updating them in ArcMap.
Here is the result obtained on the previous sample diagram:
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11. So, in the Target node priority area, click the Substation entry in the 
Element class list ordered by decreasing priorities list, drag the entry 
to the top of the list, and drop it.

12. Repeat the operation so the Feeder element class is the second 
highest priority class, and so on, for the  TransformerBank, 
ServiceLocation, ProtectionDeviceBank, and CapacitorBank element 
classes.

13. Then, look at the Multiple choices solving area. This area groups 
parameters used to decide whether the reduction will be done when 
there are several nodes of a same element class candidate to become 
the target. Make sure that the ‘Select the nearest node if conflict 
between two nodes with same priority’ option is checked.

14. From the element classes list below, uncheck all element class 
entries except the Substation, Feeder, TransformerBank, and 
ServiceLocation  entries. This means that if an ElectricNetwork_Net_
Junctions to reduce connects several Substation elements candidate 
to be the target node, the rule chooses the nearest Substation. The 
rule will also work in the same way to resolve conflict for the Feeder, 
TransformerBank and ServiceLocation element classes. 
By unchecking the other element classes in the list, if there is a 
conflict to determine the target node for several elements of these 
other classes, the ElectricNetwork_Net_Junctions to reduce will be 
finally not reduced. 
At the end of these steps, the tab content should display as follows:

7. Check the Keep vertices check box so the vertices displayed along 
the links are kept after nodes reduction and so a vertex is also 
displayed at the reduced node location.

8. Click ElectricNetwork_Net_Junctions from the Select node element 
class to reduce drop-down list.

9. In the Node connection constraints for reduction area, check 
Connection constraint and uncheck the Reduce nodes with 1 
connection so the leave nodes in the diagram are not reduced during 
the rule execution.

It’s time now to define how the topology of the network will be preserved 
after the specified node reducing, that is, to specifying the target nodes 
that will be used to reconnect the incident links related to the reduced 
nodes. By default, the Select nearest node option is checked; that is, the 
nearest node connecting to the reduced node will become the target node. 
In this sample, you will use the Select the highest priority node option so 
the target node depends on the element type of the nodes that connect the 
reduced ElectricNetwork_Net_Junctions node.
10. Check the Select the highest priority node option.
With this option, for each node connected to the ElectricNetwork_Net_
Junctions reduced node, the reduction rule will analyze the options 
specified in the Target node priority options section before detecting 
the right target node. The target element classes will be ordered from 
the highest to the lowest priority as follows: Substation, Feeder, 
TransformerBank, ServiceLocation, ProtectionDeviceBank, and 
CapacitorBank.
• Following this order, the Target node will be detected as follows: 

If among all the nodes that connect the reduced node, only one 
node belongs to the element type with the highest priority (that is 
Substation), this node becomes the target node.

• If among all the nodes that connect the reduced node, no node belongs 
to the element type with the highest priority, the rule will check if there 
is a connected node belonging to the element type defined with the 
second-level priority (that is, Feeder), and so on.

•  If among all the nodes that connect the reduced node, several nodes 
belong to the element type with the highest priority, the rule will detect 
the target node according to the options specified in the Multiple 
choices solving subsection. In this example, kept the Select the nearest 
node if conflict between two nodes with same priority option checked 
so the node nearest to the reduced node systematically becomes the 
target node when the rule detects several possible target nodes.
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15. Click OK.
16. Save the schematic project definition.
You can test the impact of this new rule on one of your generated 
diagrams by updating. Here is the result obtained on the Selection1 
sample diagram (see page 17).

Among the twenty ElectricNetwork_Net_Junction elements contained 
in the diagram, only nine of them are kept after the reduction rule 
execution—those that correspond to nodes with only 1 link connection.

As a last sample, you can analyze the diagrams obtained from a set of 
selected features in the map located near the boundaries of three counties.

The following diagram is obtained while all rules are disabled during 
the generation. It strictly displays the schematic elements related to each 
selected feature in the map.

If you want to disable the execution of one or several rules defined for a 
schematic diagram type, you only need to activate its Rules tab and click 
False in the Active field related to the desired rule item.
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Note: In this example of configuration, the generation and update 
phases can take several minutes when the diagram is based on many 
TransformerBank features. As the Spatial Query Rule execution detects 
the SecondaryLine neighbors of each TransformerBank by working 
directly on the feature class table, more time will be required to execute 
this rule depending on the number of TransformerBank features.

After having enabled all rules in the Rules tab and saved the schematic 
project definition, the resulting updated diagram opens as follows:


